Revisions

<table>
<thead>
<tr>
<th>Issue</th>
<th>Date</th>
<th>Revisions</th>
</tr>
</thead>
<tbody>
<tr>
<td>V2 Rev A</td>
<td>11/09</td>
<td>Document updated for the latest Rapid Eye V9.0 software release (12/09). New features include: full LocalView on Active Alert units, the ability to disable LocalView, and the option to set the bandwidth throughput as High/Low.</td>
</tr>
<tr>
<td>V3 Rev A</td>
<td>03/11</td>
<td>Document updated for the latest Rapid Eye V10.0 software release. Changes include hybrid support for IP cameras, and changing the Rapid Eye naming from Multi-Media to Hybrid HD.</td>
</tr>
<tr>
<td>V4 Rev A</td>
<td>09/2011</td>
<td>Document updated for the latest Rapid Eye V10 software release (build 40). This release adds IP camera support for Rapid Eye Hybrid LT units. This guide now applies to both Rapid Eye Hybrid HD and Hybrid LT units.</td>
</tr>
<tr>
<td>V5 Rev A</td>
<td>03/2012</td>
<td>Document has been put into the latest Honeywell template. Also, the document has been updated for the latest Rapid Eye Hybrid HD V10.1 software release, which adds support for new Honeywell IP cameras (equiP® 1080P, equiP® Wide Dynamic Range IP, and Performance IP) and support for ONVIF IP cameras.</td>
</tr>
</tbody>
</table>
Contents

1 Rapid Eye Remote View Software ................................................................. 5
   View Logon and Site Selection ............................................................... 5
   Starting a Live Video Session ................................................................. 6
   Automatic Video Resolution for Live Camera Windows ......................... 6
2 Using Cameras that Pan, Tilt and Zoom ......................................................... 7
   Panning and Tilting with Pull Mode PTZ Control .................................. 7
   Panning and Tilting with Zonal Mode PTZ Control .................................. 8
   Zoom ...................................................................................................... 8
3 Recorded Video ............................................................................................ 9
   Starting a Retrieval Session ................................................................. 9
   Video Playback ....................................................................................... 10
   Speed Slider ......................................................................................... 10
   Using the Skip-to-time Slider to Search for Video ............................... 10
   Using the Toolbar for Recorded Video ............................................... 10
4 Making a Video Clip .................................................................................. 11
   Playing a Video Clip Using View Software ...................................... 11
   Distributing a Video Clip on a CD or DVD ......................................... 12
   Downloading a Clip Player .................................................................. 12
5 Recorded Video from Alarms ...................................................................... 13
   A Live-Alarmed Session that Starts Automatically ......................... 13
   Video from the Time of an Alarm .......................................................... 14
6 Searching for an Event .............................................................................. 15
   Starting an Event Session ..................................................................... 15
   Using the Results of an Event Session ................................................. 16
7 Audio ........................................................................................................... 17
   Switching Audio Modes ....................................................................... 17
   Audio Toolbar ....................................................................................... 18
   Listening ................................................................................................. 18
   Talking ................................................................................................. 18
Rapid Eye Remote View Software

Before using the common operating procedures in this guide you will need to install and setup your unit, as described in the *Rapid Eye Hybrid HD Unit Quick Start Guide* or *Rapid Eye Hybrid LT Unit Quick Start Guide*, included with your unit.

**View Logon and Site Selection**

To access the Rapid Eye logon, double-click the View icon on your desktop.

Select a Rapid Eye unit in the tree on the **Sites** tab.

**First time users:** Obtain your User ID, Password and Rapid Eye central database from the Administrator of your Rapid Eye Hybrid HD/LT system.

**Tip!** A Rapid Eye unit is also referred to as a Rapid Eye site.
Starting a Live Video Session

Click **Live** after selecting a site (see *View Logon and Site Selection on page 5*). Streams from cameras are identified by a camera icon ( ). All of the streams are selected by default. Change the selection of cameras, if needed.

Click **Full Screen** ( ), or **Tile Best Fit** ( ), as needed, to customize how the Remote View application uses the screen area while viewing video. A tooltip identifies all unnamed buttons on the toolbar of the video player.

**Monitoring Many Sites at Once**

Simply select another Rapid Eye site in the View application and start another Live session.

**Automatic Video Resolution for Live Camera Windows**

To size a camera window optimally for a specific resolution, right-click the window and select **Video Resolution**. You can also size a camera window by dragging its corner; the resolution is adjusted automatically. The resolution selected for viewing live video does not affect the resolution used for recording video.

**Tip!**

A lower resolution = a smaller picture and less detail.

A higher resolution = a larger picture and more detail.

For information about connections, displaying the time, the resolution gauge and other elements of a Live Video session, refer to the *Rapid Eye Hybrid HD and Hybrid LT Remote View Operator Guide*. 
Using Cameras that Pan, Tilt and Zoom

Tip! A camera window for PTZ cameras shows PTZ in its title bar.

Panning and Tilting with Pull Mode PTZ Control

To Pan or Tilt. Move the mouse pointer onto the video picture of a PTZ camera window, then click and drag the mouse. A line is overlaid on the video and the camera moves in the direction you are pulling. Release the mouse button to stop the camera movement.

Tip! Lengthen the line to speed-up panning or tilting.

Switching Between Zonal and Pull PTZ Control

If a pull control is not displayed when you click and drag the mouse, the video player is set to Zonal mode. To switch between Zonal and Pull:

2. Select the PTZ Control mode that you want to use. This example shows Pull Mode selected.
3. You can also select the Color and Style of the drag line that appears for Pull Mode.

See Panning and Tilting with Zonal Mode PTZ Control on page 8 for more information on controlling a PTZ camera using Zonal Mode.
Panning and Tilting with Zonal Mode PTZ Control

To Pan or Tilt. Move the mouse pointer onto the video in a PTZ camera window. The pointer changes to a numbered arrow icon. Nudge the mouse in the direction that you need move the camera. The number next to the arrow indicates how much panning/tilting will occur when you click the mouse button. For continuous panning or tilting, click the arrow that is furthest from the center.

To stop continuous panning/tilting, move the mouse until the pointer changes to a white octagon, then click the mouse button.

See Switching Between Zonal and Pull PTZ Control on page 7, if you want to use pull control for your PTZ camera instead of zonal.

Zoom

Zoom. To zoom in, move the mouse pointer onto a PTZ camera window and roll the mouse wheel backward. To zoom out, roll the wheel forwards, away from your hand.

Note There is also a Dartboard control for PTZ cameras. Use of that control is explained in the Rapid Eye Hybrid HD and Hybrid LT Remote View Operator Guide.
Recorded Video

Starting a Retrieval Session

Click **Retrieval** after selecting a site (see *View Logon and Site Selection on page 5*). A stream dialog appears. All of the streams are selected by default. Change the selection, if needed. Streams from cameras are identified by a camera icon ( ). Specify a date and time **From** which to show recorded video.

If an operator requests video from a time at which the unit was not recording, the first image after the requested time is displayed and the later media indicator appears.

Later media is indicated by an icon ( ) that flashes in the upper-right corner of the Retrieval window. A report appears that indicates when media has been recorded. A report occurs when a request for a date or time is beyond the video storage’s limit, or during a period of time when recording was off.
Click Full Screen, Tile Image Size or Tile Best Fit, as needed, to optimize screen usage. A tooltip identifies all unnamed buttons on the toolbar of the video player.

**Monitoring Many Sites at Once**

Simply select another Rapid Eye site in the View application and start another Retrieval session.

---

**Video Playback**

**Speed Slider**

Change the playback speed by dragging the Speed slider. A tooltip shows the speed.

Pausing the video moves the Speed slider to the leftmost position.

Fast-forward moves the slider to the rightmost position.

**Using the Skip-to-time Slider to Search for Video**

Use the Skip-to-time slider to skip to video that was recorded earlier or later than the current video. A tooltip shows how much time will be skipped.

**Using the Toolbar for Recorded Video**

As the mouse pointer hovers over a button, a tooltip shows the function of that button.

---

**Note** The Start Recording Bitmaps button is not available to use until you enable the Allow Bitmap Save from Video feature on the New Players Options dialog box (View menu ➔ Options ➔ New Players).
Making a Video Clip

Click **Start Recording a clip** while monitoring live video, while watching recorded video or during an alarm.

Playing a Video Clip Using View Software

1. Select Clips tab.
2. Select a clip.
3. Click **Play**.

**Note** If the clip contains many video streams, a **Select Streams for Clip** dialog appears after clicking **Play**.
Navigation

If the clip file is in another folder, click to navigate to the folder.

Distributing a Video Clip on a CD or DVD

Burn video clips to DVD (or CD) media using a PC equipped with a drive, and running a program to copy the clips to the DVD or CD.

Downloading a Clip Player

A user of a PC on which Honeywell Rapid Eye View is not installed, can download a clip player from Honeywell at:


Follow the instructions on the page to logon and find the available Rapid Eye downloads. On that page, scroll past the Rapid Eye software downloads and find the link for the Clip Player - Web Edition [version number, build number]. Download the Clip Player. After the download, a REMClipPlayer.exe file is listed in a WinZip window.

Double-click REMClipPlayer.exe to install the REMM Clip Player. After setup, the Windows desktop displays the REMM ClipPlayer icon:

Run the REMM ClipPlayer and open a Rapid Eye video clip to start reviewing the video clip.
Recorded Video from Alarms

A Live-Alarmed Session that Starts Automatically

When an alarm is received, the operator connected to that Rapid Eye site will see a Live-Alarmed window, and video from all of the cameras at that site.

When the mouse pointer hovers over a button, a tooltip shows the name of that button.

Acknowledge (ACK) button turns off audio alarms. This button can acknowledge all alarms if the auto acknowledge alarms option is selected.

Note Rapid Eye View software can be configured for an Alarm session instead of a Live-alarm session. For more information about customizing alarm handling, refer to the Rapid Eye Hybrid HD and Hybrid LT Remote View Operator Guide.
Video from the Time of an Alarm

Start a Retrieval session from the time of an event by adding (or leaving) a checkmark in the box next to the alarm list, and then selecting an alarm in the drop-down list of alarms.

For more information on viewing video with Retrieval sessions, see Video Playback on page 10.
Searching for an Event

Starting an Event Session

Click **Events** after selecting a site (see View Logon and Site Selection on page 5). In the Events session, select a tab for the type of event to search for.

Select the tab for the type of event that you want to search for.

Select an event to search for. In this example, motion on Cameras 1 and 2, the Northwest and Southwest parking lots.

Select the time and date range to search for events in.

Number of search criteria selected by the user.

Progress of the search.
Selecting a search criteria, enables the **Start** button. You can select as many search parameters and criteria from as many tabs as you want. Click **Start** to search for events matching the selected criteria. The progress bar shows the status of the search.

To limit or expand the time searched for events, use the **From** and **To** fields, and change the value of the month/day/year and hour/minute/second/AM-PM options. For the dates, use the drop-down arrow to open the calendar utility.

---

### Using the Results of an Event Session

A Retrieval session starts. The events selected from the **Results** pane are listed when using the drop-down arrow, below the toolbar. To see video from another event, select that event in the drop-down list.

For more information on using the toolbar and other playback controls, see *Video Playback on page 10*. 

---
Audio for your Rapid Eye system can be set up for the Duplex audio mode (2 channels, users can talk and listen at the same time) or the Simplex audio mode (single channel audio, users cannot talk and listen simultaneously).

Switching Audio Modes

To switch from Simplex mode to Duplex mode or vice versa:

1. In the Rapid Eye View application, close any open Live windows.
2. Select the View menu ➔ Options ➔ New Players window.
3. Check/Uncheck the Simplex Audio Mode option. By default, the Simplex Audio mode will be enabled (checked).
4. Open a new Live session and observe the changes in the audio features.
Audio Toolbar

Listening

To listen to a Rapid Eye site, click 🎧 on the audio toolbar, for the channels that carry audio (channel 1 and/or 2). When Simplex audio is enabled, you cannot listen to audio and talk at the same time.

Talking

To talk to a Rapid Eye site, click 🎤 on the audio toolbar, for the channels that carry audio (channel 1 and/or 2). When Simplex audio is enabled, you cannot talk and listen to audio at the same time.

Note When using Simplex audio, there should be a 1 second delay between clicking the two Talk buttons. That is, after releasing one of the Talk buttons, the user has to wait 1 second before they click the next Talk button. If the user clicks the Talk button without waiting 1 second, the talk stream will not be enabled.